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Foreword 
 

Canadian lumber manufacturing stakeholders are now familiar with the flexibility, accuracy and user-
friendliness of the Optitek lumber breakdown simulation program. Available to Forintek members 
since 1994, it has benefited from constant improvements reflecting the developers’ innovative ideas 
as well as comments and suggestions from users. In 1997, the Conseil de la recherche forestière du 
Québec awarded Forintek its Prix Méritas for the development of Optitek. 

As sawmilling technology underwent changes over the years, Optitek was adapted to these 
changes and acquired the necessary abilities to reproduce new technology features such as curve 
sawing, true shape scanning and internal defect detection (e.g., knots). 

Thanks to its flexibility and versatility, Optitek lends itself to a number of applications, including: 

 Different slashing (bucking) strategies 

 Selection of the best breakdown patterns 

 Addition of new products 

 Modifications to wane rules and price lists in optimizers 

 Installation of optimized equipment 

 Reduction of target thicknesses or kerf widths 

 
The time had come to publish a new manual reflecting all the changes introduced into the software 
between the first version and this version 6. This manual contains an abundance of illustrations in 
the form of explanatory diagrams and screen captures to better guide users. Concrete configuration 
examples are provided throughout the document. This manual is intended for new users wishing to 
learn how to use Optitek step by step on their own, as well as occasional or regular users looking for 
answers to specific questions. 

 

 
Yves Lévesque 
Manager 
Lumber Manufacturing Technology 
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Introduction 

This training manual was designed to teach new users how to apply the Optitek log 
breakdown simulator through the different steps involved in the development of a 
simulation. It is therefore recommended to go through the sections in the same order as 
they are shown. 

The manual will also serve as a reference tool for current Optitek users in search of 
information on a specific aspect of the modeling process, such as how to represent a 
production line equipped with a curve-sawing canter. Part of the manual is therefore 
dedicated to sawmilling equipment, and provides the information necessary for the 
configuration of the different types of equipment. Machine centres are presented in the 
same order as they occur in a mill (e.g., slashing, primary breakdown, secondary 
breakdown, etc.) 

Please note: This manual is intended for users with a fair understanding of the sawmilling process. It is 
not meant to provide training or serve as a guide on the sawmilling process. Consequently, the 
document mentions a number of sawmilling-related concepts with no further explanation. 
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Installing Optitek 

Install the Optitek software from the Forintek website (www.forintek.ca). To access the 
download section, you need to be a member of Forintek in good standing with a valid 
password. 

In our website, click on Publications & Software located on the menu bar across the top, 
then on Software from the menu list on the left side of the page. Click on Optitek from the 
list of software available to Forintek members located about half way down the page.  
Enter your Forintek password at this time.  Click on Download and follow instructions on 
the screen. 

The Optitek software is available free of charge to Forintek members. The electronic 
protection key supplied by Forintek upon installation will let you use the software on a 
single computer, which prevents unauthorized copies. The electronic key is valid for one 
year, after which you will be required to download the software again from the website. 

 

Introduction to the Optitek Interface 

Here is the screen you will see when opening Optitek. 

 
 

Figure 1  Opening Optitek screen 
 

 

http://www.forintek.ca/
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The software automatically opens at the start of a new project. At this point, all 
configuration tools are empty. 

The menu bar ( Figure 1) includes the following items: 

 File 

 View  

 Simulation 

 Tools 

 Action 

 Window 

 Help 

A simulation project involves the setting of the configuration tools needed to simulate 
breakdown operations. Three basic tools are used to define simulation parameters (See 
 Figure 1), i.e., Logs, Sawmill and Grades. 

The Logs tool is used to define the raw material; the Sawmill tool specifies the 
breakdown process by configuring the machine centres and their layout in the mill; the 
Grades tool describes the sizes, grades and prices of targeted products. To complete a 
simulation, you also need to configure the Report tool, which serves to generate tables of 
results for the simulation, and indicates densities for the different species. 

Please note: When a simulation project is being saved, Optitek saves files on all four active 
configuration tools. If changes have been made to the contents of any of the tools since the previous 
back-up, the new contents are recorded. 

File Menu 

The File menu covers all operations that can be conducted with each of the project tools. 

 New:  Creates an empty tool ready to receive information. You must  
  choose which of the four tools you want to activate (Report,  
  Grades, Logs, Sawmill). If the tool you choose already contains a  
  configuration, it will be replaced with an empty file. 

 Open:  Loads an existing configuration for the tool you selected. The  
  configuration you load replaces whatever tool may already be in  
  place. 

 Open Project:  Opens an existing project. 

 Save Project:  Saves the ongoing project. As with all save functions, Optitek will ask 
  if you wish to save any tools that have been modified. 
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 Close Project: Resets all four tools after asking if want to save tools that may have  
  been modified since the previous back-up. 

 Save:   Saves configuration data in the active tool. 

 Save as: Saves configuration data in the active tool under a different name  
  without replacing the original file. 

 Save All: Saves configuration data in all active tools (Report, Grades, Logs,  
  Sawmill). 

 Recent Files: Contains a list of most recently used files to help you access them  
  rapidly. 

 Exit:   Closes the program. 

Please note: The File menu is slightly different when the Report tool is activated. In this case, you are 
offered the following options: Save Report, to save the results contained in the report in text format; and 
Save Configs, to save species density parameters and classes. 

View Menu 

The View menu lets you choose the type of presentation you want. You have the option of 
activating the Toolbar located under the menus, or the Status Bar appearing at the bottom 
of the screen. You can also use the View menu to hide the project explorer (Workspace) 
that appears by default to the left of the screen. 

The Output option only lights up when the Logs tool is on top. The output window is 
divided into tabs, and you can use it to visualize some of the results of a simulation when it 
has been checked in the View menu. 

Simulation Menu 

The Simulation menu contains the commands needed to launch a simulation once the 
tools have been configured. 

 Start: Starts the breakdown simulation on the basis of active
 configuration tools. 

 Stop:  Stops the ongoing simulation. 

 Clean:  Deletes all results from previous simulations. 

 Batch:  Lets you program several simulations with different files; the 
 program will run the different simulations consecutively (See Step 
 6 in Chapter 2 for more details). 
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 Settings: Lets you access configuration panels for the different parameters 
 controlling the simulation (See “Setting Simulation Parameters” in 
 Chapter 2). Note that one of these parameters is the selection of 
 units of measurement. For example, you may define the logs in the 
 metric system in the Logs tool, and the products in the Imperial 
 system in the Grades tool. 

Tools Menu  

The Tools menu lets you access configuration panels for the Logs and Grades tools by 
clicking on the corresponding sub-menus. Note that you can access the Sawmill tool 
directly by clicking on the Project Explorer to the far left of the screen. 

The Tools menu also includes a Species & Densities sub-menu for you to define wood 
species and the corresponding densities. This information is used to calculate the mass 
and value of chips and sawdust. 

Action Menu 

Each window in the document (Sawmill, Logs, Report) includes a different Action menu 
listing specific actions for the active tool. These commands will be detailed within the 
relevant sections below. 

Window Menu 

With the Window menu, you can easily control the layout and status of the windows using 
regular Microsoft standards. The tools (Sawmill, Logs, Grades and Report) are in separate 
windows, and you can view them individually or as a group. 
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Creation of a Simulation Project 
You will find it convenient to create a specific directory to store all your files relating to a 
given simulation project. To perform a simulation project, use the following steps. 

 
 

Step 1 – Setting Simulation Parameters 

In the Simulation menu, click on Settings ( Figure 1) to display the parameter control 
panel. 

 
 

Figure 2 Opening simulation parameters 
 

Setting Units of Measurement 

Use the Units tab ( Figure 3) to select units of measurement (Imperial or Metric). All 
parameters are metric by default. Make sure that you enter your data in the same format 
as selected here. If you change units of measurement at a later time, all data will be 
converted into the numeric system you have selected. 

 



 9 
 
 
 

 
 

Figure 3 Unit tab in the Simulation Settings window 
 

Setting Result Display Options (Outputs Tab) 

The Outputs tab ( Figure 4) contains the following parameters: 

 Process Options 

Check this option if you do not wish to display solutions graphically during the 
simulation ( Figure 4). 

 Generate products file 

Check this option to allow the simulator to create a file (.prd extension) containing all 
the results generated from the breakdown of each log. The products file may be 
Standard or Detailed.  If you choose Detailed, all geometric points for each log and 
each product will be saved. 

 Generate optimal solution trace file 

When you check this option, the simulator creates a file (.trc extension) containing 
information on the path of each section from the original piece throughout the mill. 
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Figure 4 Outputs tab in Simulation Settings window 
 

Setting Optimization Options  

Use the Optimization tab ( Figure 5) to select the type of optimization you want: according 
to product and by-product value, or to resulting lumber volume. The option Use by-
products densities in solution calculation under the Value setting lets you decide 
whether you want to consider wood density in the calculations. With this option, you can 
ignore the value of by-products in the calculation of optimum solutions. 

Please note: If you optimize for value, you need to make sure that every product has a value other than 
zero, or else the corresponding product will not be generated in the simulation. 
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Figure 5 Optimization tab in the Simulation Settings window 
 

Setting Visualization Options 

The Visualization tab ( Figure 6) lets you set the parameters used to control the display of 
logs before breakdown and after breakdown, i.e., the logs with the products within them. 
Unless you have a very specific reason to do otherwise, we recommend that you stay with 
default settings. Here is a brief summary of the various options: 

 Log length ratio:  Lets you change the ratio used to display log lengths. The default 
setting is quarter size. 

 Use textures:  Lets you visualize the logs with or without textures 

 Use transparency:  Lets you visualize the logs with or without transparency 

 Use wire frame mode:  Lets you visualize the logs in wire frame mode (lines) 

 Use dot frame mode:  Lets you visualize the dots defining the logs  

 Use log smoothing:  Lets you smooth out log surfaces 

 Draw log shape:  Lets you visualize the outline of the logs 

 Draw log ends:  Lets you visualize log ends 

 Draw products:  Lets you visualize the products within logs 
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 Draw defects:  Lets you visualize defects within logs 

 Show only in products:  Lets you visualize defects within products 

 Show only on surface:  Lets you visualize only contact points between defects and 
products 

 Log precision:  Lets you select the level of log precision (number of polygons) 

 Objects quality:  Lets you select the level of log resolution (texture) 

 Use lights:  Lets you activate a light to add shadows over the logs 

 High quality:  Lets you increase the precision obtained with lights 

 Use joystick motion style:  Lets you change the way you use the mouse to move 
the logs 

 
 

Figure 6 Visualization tab in the Simulation Settings window 
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Step 2 – Defining Species and Densities 

In the Tools menu, click on Species & Densities. 

 
 

Figure 7 Using Tools menu to access species and densities definition 
 
 

Defining Wood Densities 

Wood density is used to calculate the mass of by-products generated in the breakdown 
operation. Define the make-up of your lot of logs by entering the name of each species, its 
percentage in the lot, and its density ( Figure 8).  The density is expressed in the units 
selected in Simulation Settings (kg/m³ or lb/ft³). 
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Figure 8 Window used to enter wood species and densities 
 
 
 

Step 3 – Setting Log Configuration 

Use the Logs tool to define the logs for the simulation project. In this case, the term  
“Logs” is applied generically to both logs and stems. 
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Figure 9 Opening Logs tool 
 
Optitek can represent the wood supply in three different ways: 

 Artificial log  

An artificial log is the easiest to define, as it has only one curvature (sweep), and its 
different sections are circular polygons. 

 Two-axis log 

Defining a two-axis (or X/Y) log is more complex, as it consists of a series of sections 
forming elliptical polygons, the positions of which may vary vertically (Y axis) and 
horizontally (X axis) along a longitudinal axis (Z axis). 

 True shape log 

A true shape log consists of sections defined by points based on data provided by 
scanners. 

Defining an Artificial Log  

From the Tools menu, select Logs definition. Click on Add and select Artificial ( Figure 
10). 
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Figure 10 Window used to define an artificial log 
 

Name
Enter a name to identify the log in order to trace it in log lists and reports. Use a maximum 
of eight characters (letters from A to Z, digits from 0 to 9, and symbols «.» «,» «-» and 
«_»). 

Length 
Log length. 

Large-end diameter 
Log diameter at the stump end. 

Small-end diameter 
Log diameter at the top end. 

Sweep 
Distance between the axis joining the geometric centres of the large- and small-end 
sections and the geometric centre of the central section ( Figure 11). 

Number 
Number of times the same log profile appears in the set of logs. 

Points/Section 
Number of points used to represent each of the log sections. Optitek treats log sections as 
circular polygons, and the default is 40 points per section. To define logs with greater 
precision, you may use up to 60 points. 

Sections/Log 
Number of sections used to define a log, the default being 11 sections. You must enter a 
minimum of three sections. Please note that Optitek will turn any even value you may 
enter into an odd value. 
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When you have entered all the parameters, click on OK to create the log and add it to the 
list. 

 

 
 

Figure 11 Representation of log sweep 
 

Defining a Two-axis Log  

From the Tools menu, select Logs Definition. Click on Add and select Scanned Two 
Axis. 

 
 

Figure 12 Window used to define a two-axis log 
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Name 
Enter a name to identify the log in order to trace it in log lists and reports. Use a maximum 
of eight characters (letters from A to Z, digits from 0 to 9, and symbols «.» «,» «-» and 
«_»). 

Number 
Number of times the same log profile appears in the set of logs. 

Points per section 
Number of points used to represent each of the log sections. Optitek treats log sections as 
circular polygons, and the default is 40 points per section. To define logs with greater 
precision, you may use up to 60 points. 

List of sections 
The list of sections is located at the bottom of the window. Each log is defined by a series 
of sections. Each section is defined by its position along the longitudinal Z axis of the log, 
its diameter along the X axis, and its diameter along the Y axis ( Figure 13) as well as the 
coordinates of its centre (X and Y) ( Figure 13). 

If a log is fed small-end first, the first section of the large end should be defined as position 
zero along the longitudinal axis. Keep in mind, however, that data provided by a scanner 
are normally in the reverse order, the zero being applied to the small-end entering the 
scanner. To adequately process these data in Optitek, you have to reverse them. 

 
 

Figure 13 Representation of log sections 
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Face view 

The geometric centre of the first section determines the reference axes for the following 
sections. If, for example, the X and Y positions of a section are greater than zero, the 
section will be offset to the top right from the geometric centre of the first section ( Figure 
14). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 14 Face view 
 

Defining a Log in True Shape Format  

Logs in true shape format are based on data generated by a scanner that defines each 
section with polygons involving a relatively high number of points, typically 60 to 120.  To 
process them in Optitek, you must enter the data in a binary file compatible with the 
Optitek format. Use the Log Converter conversion tool, accessible from the Action menu 
when you have selected the Logs tool to convert data from most brands of scanners into 
a format compatible with Optitek. 

To load the converted logs into Optitek, go to the Tools menu and select Logs Definition. 
Then click on Add and select True Shape. 
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With the True Shape Advanced format, you can include internal log defects such as knots. 

 
 
 

Please note: To open a previously saved log file, go to the File menu, click on Open and select the 
desired log file (.log extension). The file you open replaces the existing log list if any. To add logs to an 
existing list, click on Import  in the Tools\Logs Definition menu and indicate the log file name. 

Keyboard Shortcuts to Control Log Visualization Parameters 

When the Logs window is active, you may use keyboard shortcuts to rapidly modify some 
visualization parameters with no need to go back to the Visualization tab under 
Simulation\Settings. A number of options are only valid for 3D visualization. Some have 
no equivalent in the menus and are accessible exclusively through the keyboard. 

   Key 'W': Activate/De-activate wire frame mode (3D only) 
 
   Key 'R': Resets diagram (2D only). In 3D mode, the log depth effect is modified. 
 
   Key 'X': Deletes texture (3D only) 
 
   Key 'E': Activates/De-activates “Draw log ends” option (3D only) 
 
   Key 'T': Activates/De-activates “Use transparency” option  
 
   Key 'L': Lets you visualize products without seeing the outline of the log 
 
   Key 'C': Activates/De-activates the “Draw products” option (3D only) 
 
   Key 'D': Lets you visualize internal defects (3D only) 
 
   Key 'V': Lets you shift from 2D to 3D  
 
   Key 'N': Displays next product 
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   Key 'A': Displays all products 
 
   Key 'P': Displays previous product 
 
   Keys ‘2’, '4', ‘6' and '8': 
  Let you move the log (2D only). In 3D, you can move the log with the mouse. 
 
   Keys '-’ and '+’: 

In 2D, let you delete sections to visualize only the end section. In 3D, let you 
display individual internal defects. 

 
   Key 'S': Lets you isolate individual logs and their products within a stem 
 
   Key 'F': Displays all defects in a product 
 
 

Step 4 - Defining Grades 

The Grades tool lets you set all the parameters involved in defining your target products 
(lumber) and by-products (chips and sawdust). Lumber products are defined in terms of 
dimensions, grade and value per piece. By-products are defined in terms of financial value 
per unit of mass. 

In the Tools menu, click on Grades Definition. 

 
 

Figure 15 Opening Grades menu 
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The Grades tool includes four tabs: 

 Nominal Dimensions 
 Grading Rules 
 Products’ Definitions 
 By-products 

 
Nominal Dimensions Tab 

The first step in defining target production is to write a list of all product dimensions. Start 
with a table of thicknesses, entering a nominal value and its actual equivalent for each 
thickness. Click on Add to insert these values into the list.  Then repeat the procedure with 
all other dimensions ( Figure 16). 

 
 

Figure 16 Creating a table of thicknesses 
 
 

Grading Rules Tab 

Each product must be associated with a wane rule that is used to determine its grade and 
financial value. In the Grading Rules tab, list the names of all defined rules. To add a new 
rule, enter a name in the appropriate field, and click on Add ( Figure 17). 
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Figure 17 Grading Rules tab 
 
 

A grading rule consists of one or more grades identified under a single name. Make sure 
that you include all the grades that may exist in a given rule. For example, the framing rule 
for a 2x4 may include Grades #2 & Better, #3 and #4. 

To define a rule, select one grading rule in the list and click on the Definition button. Then 
click the Add button at the top of the window.  Number 1 appears as the name of the first 
grade ( Figure 18). To change this name, enter alphanumerical characters (e.g.: 
“2&better”). Then specify what percentage of wane is allowed for thickness, width and 
length. Click on the Add button next to the wane fields.  If you want to allow for an 
equivalence rule  for the grade defined, enter the corresponding values of allowable wane 
for thickness, width and length, and click on the Add button next to the wane field. To 
enter another grade, repeat the above procedure by clicking the Add button at the top of 
the window. Number 2 appears as the name of the second grade. 

You can also use NLGA grading rules by clicking on NLGA Default (See  Figure 17) 

Please note: The order in which you create grades is critical, as grades are added in the same order as 
you enter them. When grading a piece of lumber, Optitek assigns the first grade meeting the allowable 
percentage of wane. 
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Figure 18 Grade definition  
 
 

Products Definition Tab 

To create a product, go to the Products Definition tab and click on the scrolling lists to 
select the applicable thickness, width, length and grading rule. Click on Add. The product 
is added to the list ( Figure 19). To remove a product from the list, highlight the product and 
click on Remove. 
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Figure 19 Product definition 
 
 

To insert financial values for the different products, click on Value. If a product contains 
more than one grade, you must enter a value for each grade. The values to be entered 
are expressed in dollars per piece ( Figure 20). 
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Figure 20 Entering financial product values 
 
 

As the logs are converted into lumber, Optitek classifies each product under the first grade 
corresponding to the wane percentages found in the piece. If value is the optimization 
criterion defined in Settings Simulation, Optitek considers the value assigned to the 
product in determining the best breakdown solution ( Figure 5). All values must be different 
from zero, as products with zero value will not be generated.  If you choose to optimize for 
volume, Optitek will ignore values and optimize for the basis of volume recovery. 

You can also modify product values rapidly by going to the Grades tool in the Project 
Explorer. To change the values assigned to a product, double-click on the product. A 
window containing a field for each grade will pop up ( Figure 21). 

 



 27 
 
 
 

 
 

Figure 21 Grades window in Project Explorer 
 
 

By-Product Tab 

The by-products are chips and sawdust. Enter values for these by-products in dollars per 
metric ton ($/MT) or dollars per Imperial ton ($/IT)  ( Figure 22). 

During the conversion process, Optitek calculates the volumes of by-products generated; 
it then multiplies these volumes by the average wood density for the lot as specified in the 
simulation to determine the mass of the two types of by-products. The mass of each by-
product is multiplied by its unit value to generate its total financial value. Note that, if you 
have chosen to optimize for value, Optitek does not take by-product value into 
consideration unless you have checked the Use by-products densities in solution 
calculation option under the Optimization tab in the Simulation Settings menu. 
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Figure 22 Entering by-product values 
 
 

Please note: The format of Grades files is different from that used in previous versions. They use a .dbx 
extension rather than .db. The new format is compatible with data relating to grading rules for knots. 
Grades files from previous versions are still supported when you load the files but they get converted to 
the new format when you save your modifications. 

 
 

Step 5 – Defining the Sawmill  

This is the most demanding and the longest step. A whole section of the manual is 
dedicated to it, and we therefore refer you to Chapter 5, where you will find all the 
information needed to configure the different machine centres. 

Step 5 must be completed before you can move on to Step 6. 
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Step 6 – Breakdown Simulation 

Before you start the simulation, there are a few points that you should check: 

 Go to the Tools menu and click on Logs Definition to make sure that the logs you 
want to simulate have been adequately selected. You can also visualize this 
information in the Project Explorer. 

 Check whether the optimization criterion is what you want (value or volume). If you 
have chosen to optimize for value, make sure that each piece of lumber has a value 
other than zero. 

 With the sawmill tool active, you will find a tool to check for errors or anomalies in the 
configuration of the sawmill under the Action menu; click on Validate layout. This will 
run automatically during the log conversion process, and warn you of any error. 

To start a simulation, go to the Simulation menu and click on Start ( Figure 23). Or click on 
 (blue triangle) in the tool bar. You can also start a batch of simulations that will be 

performed consecutively. Select Batch in the Simulation menu; a window similar to that in 
 Figure 25 will pop up. For every simulation you want, enter a name for the results file 
(output) that will be generated in text format. 

During the conversion process, the Processing solution window ( Figure 24) appears on 
the screen, indicating that Optitek is searching for solutions.  By clicking on the Stop 
button you can tell Optitek to stop the conversion process when the on-going log 
simulation has been completed. At that point, a Kill button appears. By clicking on this 
button you can terminate the current simulation immediately. This, however, may make 
Optitek unstable. 

 



30  

 
 
 

\  
 

Figure 23 Starting a simulation 
 
 

 
 

Figure 24 Processing solution  window 
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Figure 25 File definition window for batch conversion 
 
 

Step 7 – Setting the Report Format  

Use the Report tool to generate a complete report on the simulation results. 

Note that the report shown on screen provides the results of a simulation that is still in the 
memory. If you wish to keep a copy of the report, print it by clicking on the Print button in 
the tool bar at the top of the screen, or save it so you can retrieve it in a word-processing 
or spreadsheet program. One advantage of the latter method is that it allows you to further 
process the results. To save the report, you can either go to the File menu and click on 
Save Report, or to the Action menu and click on Save Report. 

To define the report format, go to the Project Explorer, click on Report, and then click 
on Results Options in the Action menu ( Figure 26). In the pop up window, verify the 
options that are checked are those you want to include in the report (all options are 
checked by default). 
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Figure 26 Setting the report format 
 
 

Defining Log Classes 

Log classes are used to sort logs into groups having similar parameters. You define the 
classes by setting your own intervals ( Figure 27). 

While in the Report tool, go to the Action menu. Click on Define Classes. In the Classes 
Definition window, check the criterion you want to use as a basis for your log classes. 
(The units of measurement are those defined in Simulation\Settings) 

The log class types available are as follows: 

None  : No log classes. All log results are shown individually 
Name  : Classes  based on stem or log names 
Length   :  Classes based on log length 
Volume   :  Classes based on  log volume 
Sweep   :  Classes based on log sweep 
Taper   :  Classes based on log taper 
Small diameter :  Classes based on small-end log diameter 
Large diameter :  Classes based on large-end log diameter 
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Figure 27 Selection of log class criterion 
 
 

In the example below ( Figure 28), we have defined three classes according to small-end 
log diameters. Logs with small-end diameters under 15.1 cm are placed in the “small” 
class; those with diameters between 15.1 and 25.1 cm are in the “medium” class; and 
those over 25.1 cm are in the “large” class. 

Name-based classes are used to sort logs according to original names (defined in the 
Logs tool) or to names assigned to the logs in the mill’s counters (CNTR Machine Centre). 

The default is None, which means that the results are shown for individual logs. 
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Figure 28 Example of class definition 
 

Wood Type 

If you are dealing with logs from identified stems, check a box under Wood Type to display 
simulation results for complete stems or individual logs. 

Please note: To display simulation results on an individual log basis when the wood supply is in stems, 
remember to include one or two counters behind the slashing station in the mill layout. 

 
 

Step 8 – Report Generation 

Once you have defined your log classes, click on Reset and generate and the report will 
appear on screen. Click on Print to print out your results. 

To save this report, you may go to File and click on Save Report or to the Action menu, 
and click on Save Report. The report is then saved as a text file (.txt extension) that you 
can read easily in a spreadsheet such as Excel or a word processing program. 
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To save your log classes for later use in other simulations, go to the File menu and select 
Save Configs. A new file (.rpt extension) is created; it also contains your data on wood 
species densities. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 29 Saving a report 
 
 

Step 9 – Saving a Project  

A project consists of all the files needed to perform a simulation. To save a project, go to 
the File menu; click on Save Project and name the project. Optitek creates a file (.sim 
extension) to save all active configuration files (sawmill, logs, grades and report), which will 
allow you to automatically reopen all the project’s files with a single command. 

 

 



36  

 
 
 

 



 

  

Chapter  3  
General Information on the Configuration of 
Machine Centres  
 

Positioning and Breakdown    38 

Rotation, Alignment and Translation   39 

Input and Output   40 



38  

 
 
 

General Information on the Configuration of 
Machine Centres 

 
 

Positioning and Breakdown 

A conversion centre or machine centre can be described as the combination of two distinct 
operations: a positioning centre and a cutting centre ( Figure 30). The configuration of a 
machine centre is essentially a matter of defining the type of positioning and the type of 
breakdown taking place at the centre. 

The type of positioning describes how the logs or lumber are presented to the cutting 
tools. The configuration process consists of selecting the type of positioning applicable to a 
given machine operation from a variety of positioning options. Positioning options vary with 
the different machine centres. With some positioning options, the best position can be 
determined in terms of rotation, alignment or translation, as we will see later on. 

The type of breakdown defines the parameters involved in the breakdown operation and 
the resulting product dimensions. These parameters include: saw kerf widths, number of 
saw blades, opening of chipper-canter heads and saw blade positions. 

 

Please note: If several openings or position lists are specified as breakdown parameters, Optitek tries all 
possible combinations and retains the solution providing the best results in terms of volume or value 
recovery, according to the optimization mode selected. 

 Positioning centre Cutting centre  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 30 Position centre and cutting centre 
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Rotation, Alignment and Translation  

When configuring a machine centre, you must take care to adequately represent the way 
the log or piece of lumber is presented to the cutting tools. You need to understand the 
fundamentals of positioning, which consist of locating the wood before the cutting tools in 
relation to a reference axis, before proceeding to the breakdown operation.  

The positioning of the piece of wood involves three degrees of freedom: rotation, 
alignment and translation. These three parameters control positioning. 

 
 

Figure 31 Log positioning 
 
 

Rotation 

By positioning the log in terms of rotation, you set its position in rotation around the Z axis 
( Figure 31). A good comparison might be the rotation of a rolling pin around its handles. A 
clockwise rotation is said to be positive. Rotations are defined in fixed increments 
measured in degrees; for example, in the search for the best solution, the log could be 
rotated in fixed increments of 10 degrees. Rotations are only possible with logs that have 
not been cut; for this reason, the rotation parameter is not used in secondary breakdown 
machines. 
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Please note: If the rotation parameter is zero, log sweep is automatically on top (horns down). 

Alignment 

By positioning the log in terms of alignment, you set its position around the Y axis ( Figure 
31). The large end of the log is fixed, while the small end is re-aligned against the cutting 
tools. This parameter is used in searches involving split taper or full taper sawing. 

Searches are performed in fixed increments measured in degrees. Note that, in the case 
of full taper positioning, the piece of wood is always off-centered to the left. 

Translation 

By positioning the log in terms of translation, you set its position along the X axis ( Figure 
31). Searches in translation are also performed in fixed increments, but in this case they 
are measured in centimetres or inches. A translation to the right is said to be positive, 
while a translation to the left is negative. Note that right and left refer to the perception of 
an observer located behind the log and looking at the machine infeed. 

When both translation and alignment parameters show zero, log positioning is perfectly 
centered. 

 
 

Input and Output 

Most machine centres are equipped with an Input button that you can use to retrieve a 
pre-defined solution (positioning and/or breakdown) and an Output button for saving 
optimum solutions (positioning and/or breakdown). Input and output involve a text file (.sol 
extension). You must enter the name of the file to be used to save or retrieve solutions. 

Positioning 

In the case of positioning, the format of each line depends on the number of degrees of 
freedom the particular breakdown centre offers. Data are always recorded in metric units, 
even if your sawmill settings are in Imperial units. The file must have as many input lines 
as there are logs in the simulation ( Figure 32). 
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Number of 
subsequent 

columns 

Rotation Alignment Translation Log # : 
“0” 

for the 
first log 

Figure 32 Typical file format (.sol) used for wood positioning at a primary conversion centre 
 
 

Breakdown 

In the case of breakdown, if the configuration uses Openings set, the format of each line 
in the file will only specify a value ( Figure 33). If, on the other hand, the configuration uses 
Positions set, the format of each line in the file must specify as many values as defined in 
the configuration. Units of measurement are always metric, whatever the units you 
selected in the Sawmill tool. 
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In this example, the last column 
contains the head opening solution 
retained for the breakdown. The first 
column shows the log # (“0” for the 
first log) 

 
Figure 33 Typical file format (.sol) for breakdown using openings set 

 
 

Using Input Files 

Use the Input button to specify the name of the text file containing the solutions you want 
to use. Keep in mind that the data in this file are added to data already specified in the 
breakdown centre's configuration. Consequently, if you wish to apply the solutions saved 
in the .sol file to read the openings of a twin band headrig, for example, you need to 
configure the machine for a single opening of zero under Breakdown; then click on In: 
Browse and enter the name of the file containing the solutions. 

If, on the other hand, your purpose is to read a file showing positioning errors, such as a 
file containing rotation errors on individual logs, use the normal machine configuration, 
and add the name of the file containing positioning errors by clicking on the Input button. 

Please note: If you want to use a solution file created in Imperial units in Optitek version 5 or older, go to 
the Simulation\Settings menu and check option Load solution files (.sol) as imperial units. 
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Non-configurable Machine Centres 
 
The machine centres described in this section can neither be configured nor deleted as 
they are necessary to any sawmill configuration. You will find them in the space dedicated 
to sawmill layout diagram, in the top left corner when you start defining the mill. There is 
only one setup for each in all mill layouts. 

 
 

Feeder  

A feeder ( Figure 34) provides a piece of wood to another machine centre. It is the machine 
centre that transports the logs in the Logs tool, one at a time, towards the different 
sawmilling centres. Any sawmill configuration must therefore begin with a feeder. 

 
 

Figure 34 Graphic representation of a feeder 
 
 

Sorting Table  

The sorting table ( Figure 35), or green chain, receives the products in the different 
dimensions according to associated wane rules. This is the machine centre where the flow 
of lumber in the sawmill configuration generally stops. 

 
 

Figure 35 Graphic representation of a sorting table 
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Chipper  

The residue chipper ( Figure 36) turns lumber that is unacceptable for reasons of size or 
quality such as slabs, edgings or trimmings into chips. The chipper must therefore be 
connected to machines generating chippable residues. 

 
 

Figure 36 Graphic representation of a chipper 
 
 

Inspector 

The inspector ( Figure 37) is a tool used to debug simulation projects. It lets you see what 
goes on at a particular machine centre during the breakdown operation. The inspector 
systematically memorizes all the cutting solutions that have been tried, whether the 
resulting lumber is merchantable or not. Whenever several potential solutions have been 
specified in the configuration of the machine centres connected to the inspector, each 
solution is tested, and you can visualize the resulting piece of wood. If several cutting or 
positioning options have been configured at the different machine centres, the total 
number of possible solutions can be considerable. 

If, for example, two tests have been specified for the first machine centre and three in the 
second, each piece will be displayed six times if the inspector is connected to the outflow 
of the second machine centre. After connecting the inspector to the outflow of one of the 
machine centres you want to inspect, start the breakdown operation as usual. To visualize 
the results of different trials, go to Project Explorer; click on Logs; and then click on 
Inspector. 

 
 

Figure 37 Graphic representation of an inspector 
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Configurable Machine Centres 
 
To add a machine (or machine centre) to the sawmill, go to the Action menu, click on  
Add machine and select the desired machine centre from the list. 

 
 

Figure 38 Adding a machine 
 
 
Each icon comes with a contextual menu that you can access by clicking with the right-
hand button of your mouse. This menu allows for the following actions: 

Configure: Gives you access to the configuration window for the machine 
Remove: Removes the machine from the sawmill 
Print: Prints the configuration of the machine 
Copy: Creates a copy of a machine with the same configuration. 
 
You can also access the configuration window of a machine centre by double-clicking the 
corresponding icon with the left button of the mouse. 
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Figure 39 Using contextual menu to access machine configuration window 
 
 

Slasher 

The slasher is a machine equipped with one or more circular saw blades to slash stems 
into logs. 

This machine centre contains one inflow and two outflows. The inflow normally receives 
stems. The resulting sawlogs outflow through the top button, while leftover logs are sent to 
the lower button ( Figure 40). 

 
 

Figure 40 Slasher inflow and outflows 
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Positioning 

Always select Large end at origin and leave translation parameters at zero 

 
 

Figure 41 Slasher positioning configuration 
 
 

Breakdown 

Saw Positions by Length Set  

Slashing takes place in relation to the full length of the stem. For all practical purposes, this 
is similar to manual, stem-by-stem slashing based on the full length of the stem. Each line 
corresponds to a cutting instruction along the full length of the stem. The length is the first 
number of each line. Saw blade positions are indicated by the subsequent numbers, and 
they are always shown in relation to the reference axis, i.e., the large end of the stem. The 
order in which you enter the lines does not matter, as Optitek automatically sorts entries in 
order of decreasing lengths. 

In  Figure 42, Optitek checks the length of every stem to be slashed. If the stem is 600 
inches or longer, it will be slashed at saw positions 200, 400, 600, 700 and 800 inches. 
The first three logs will be 200 inches in length, and the next two logs may be 100 inches 
or less (depending on total stem length). The last log will only be kept as a sawlog if its 
length exceeds a minimum set to 60 inches.  If the length of the stem is less than 600 
inches but equal to or greater than 384 inches, saw positions for the second stem apply. 
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Figure 42 Example of configuration with saw positions related to stem length 
 

Dynamic Programming (Optimized Stem-by-stem Slashing) 

Dynamic programming tries to identify the best combination of logs in a given stem. It 
allows for the recovery of more than one log within a given stem, as well as the elimination 
of certain log sections in-between target logs. 

Please note: When you select dynamic programming as the breakdown mode, you must not set any 
translation parameter under Positioning. 

To use Dynamic programming, you need an understanding of concepts such as search 
steps, minimum length and length list. The search step is the increment used in the search 
for optimum solutions. If, for example, the search step is 30 cm, the optimizer analyzes the 
stem in 30-cm increments all along its length. 

The minimum length is the length threshold between the upper and lower outflow buttons. 
Logs shorter than the minimum length are sent to the lower button, which is usually linked 
to a chipper (DECH). The minimum length is the shortest possible length than can be 
processed on the production line. 
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The length list is the list of all lengths that the slasher can produce. It must include all the 
log lengths to be sent to the production lines and, possibly, shorter lengths to eliminate 
defects between target lengths. Irrespective of the order in which the lengths are entered, 
Optitek sorts them in decreasing order. Make sure that the search step you select is a sub-
multiple of all the lengths defined in the length list. 

In  Figure 43 we have assumed log lengths of 150, 400 and 650 cm. The minimum length 
is 150 cm, the step is 25 cm and the shortest length that can be produced by the slasher is 
50 cm. 

 
 

Figure 43 Example of configuration by dynamic programming 
 
 

Example A 
A stem, 6 metres in length with a crook, could be slashed into a 4-metre log and a 1.5-
meter log, the crook being sent to the chipper. 
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Figure 44 Example of a solution obtained from a 6-metre stem with a crook 
 
 

 Example B 
A 7-metre stem, one end of which is considered non-recoverable, could be slashed to 6.5 
metres, the non-usable end being sent to the chipper. 

 
 

Figure 45 Example of a solution obtained from a 7-metre stem with one non-usable end 
 
Positions Set  

 
 

Figure 46 Bunch slashing 
 
With this option, you need to determine the position of each saw in relation to the 
reference axis originating in the large end of the stem ( Figure 46). Although Optitek 
processes one stem at a time, this type of slashing is applied to bunch slashing.  Note that 
the saw kerf width is not considered in slashing calculations. 
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Figure 47 Example of configuration whereby all stems are slashed into 100-inch logs. 
 
 
Positions by Diameters Set 

In this type of slashing, an operator makes decisions one stem at a time in relation to 
large-end diameters. This mode covers slashing operations according to rules combining 
such concepts as limit diameter, relative reading position (distance to large-end), reading 
span and saw position). 
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Each line represents a slashing rule related to the 
larger diameter of the remaining stem. The 
parameters applied are: diameter, distance, span 
and position, in this order. The logs are described 
in decreasing order of diameters. 

Diameter parameter: 
Minimum diameter required for the slashing rule to 
be applied. 

 
Distance parameter: 
Position in relation to the large end of the 
remaining stem, where diameters are measured. 

 
Span parameter: 
Span over which the diameter average is 
calculated. The span is divided into two and 
applied to each side over the specified distance. 

 
 Position parameter: 
Slashing position from the large end of the 
remaining stem. 

Figure 48 Example of slashing to 16 or 8 feet 
 
 
In this example ( Figure 48), stems are slashed to 16 or 8 feet. The minimum diameter for 
a 16-foot log is 5 inches. Logs with diameters below 5 inches would be slashed to 8 feet. 
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Twin Blade Saw 

Twin Blade Saw refers to machines equipped with two blades (band or circular) mounted 
on separate mobile frames. 

 
 

Slab 
Log inflow Two-sided cant 

Straight-cut slab 

Figure 49 Graphic representation of a twin blade saw 
 
 

This machine centre ( Figure 49) includes one inflow (left-hand button) and three outflows 
(right-hand buttons). It normally processes logs or two-sided cants, which it cuts into three 
pieces. The left slab outflows through the top button; the right-side slab through the bottom 
button; and the two-sided cant or cant outflows through the centre button. 

Positioning 

Previous position 

With this option, you use the same positioning as with the previous machine centre, which 
lets you focus the search on alignment and translation. This arrangement is used when 
the twin blade saw is located right behind a chipper-canter. 
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Figure 50 Previous position positioning option 
 

In this example ( Figure 50), the selection of “Previous position” comes with a translation 
search in ½-inch steps over a 1-inch span each side of a split taper. Optitek calculates the 
optimum solution for the different trials. For more information on alignment and translation, 
refer to Chapter 3, Rotation, Alignment and Translation, page 39. 

Sweep up 

With this option ( Figure 51) the sweep of the log is automatically on top (horns down). With 
this type of positioning, you can search for the optimum position in alignment, translation 
and rotation (Refer to Chapter 3, Rotation, Alignment and Translation, page 39 ). 

 
Figure 51 Sweep up positioning option 
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Centering 

Once you have selected basic positioning, you need to specify how the piece is to be 
centered with respect to the cutting tools 

 
 

Figure 52 Centering options 
 
 
Full taper 

With this option, the log is automatically aligned according to its taper (full taper). The 
origin of the Z reference axis runs through the centre of the large diameter of the log and 
continues parallel to the left-hand side of the log ( Figure 53). 

 
Figure 53 Full taper position 
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Split taper 

This option sets a centered reference axis (split taper), but the axis does not necessarily 
run through the geometric centres of both ends. The reference line starts at the centre of 
the large end, and it continues at the centre of the support, the log being held by its sides, 
as would be the case when self-centering belts are used. 

Centering by ends 

 
Figure 54 Centering by ends 

 

With this option ( Figure 54), the reference axis is centered and runs through the geometric 
centres of the large and small ends of the log. Use this option when you need to centre log 
ends, as with an end-dogging system. 

Breakdown 

Openings set 

This type of breakdown automatically centres the width of the opening in relation to the 
reference axis determined in the selection of a positioning mode. Depending on whether 
you chose full taper or split taper, you will get different results from the “Openings set”. 
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You may specify different openings in a simulation. Optitek will select the opening that 
optimizes volume or value yield (according to your selection criterion). If you specify two 
openings, Optitek successively breaks down the log with these two openings, and selects 
the opening that provides the better yield in terms of volume or value. 

 
 

List of available 
openings 

Enter each opening 
value and click on Add 

Saw 
kerf 

Figure 55 Openings set option 
 
 
Positions set 

All positions are determined in relation to the reference axis you selected (full taper or split 
taper), but you must decide on actual saw positions. 

The parameters to be entered are the saw kerf width, the position of the left-side blade, 
and the position of the right-side blade. In calculating saw positions, you need to consider 
saw kerf thickness and remember that positioning applies to the left-side cut. 

Example 
 
Calculation of saw positions for a 10-cm opening centered on a centered reference axis 
(split taper), with a saw kerf of 0.5 cm ( Figure 56). 
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Figure 56 Typical calculation of saw position 
 
 

You need to apply one-half of the opening (10 cm/2 = 5.00 cm) on either side of the 
reference axis you selected to ensure that the cant is perfectly centered. Calculating the 
width of the right-side saw kerf is easy, as it is the left-side blade that determines the width 
of the cant. You can therefore enter 5.00 cm. When you calculate the position of the left-
side saw, the width of the cant is determined by the right face of the blade. You therefore 
need to consider saw kerf width. The position you must enter is –5.50 cm, i.e., 5.00 cm + 
0.50 cm. 

Note:  For saw positions to the left of the reference line, the saw position must be a negative value.  
Saw positions with a positive value will be positioned to the right of the reference line. 
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Openings by diameters set 

This type of breakdown is similar to Openings set, but it lets you associate the small-end 
diameter1 of the log to a specific opening. You can therefore pre-select an opening for 
each of the diameter classes you may have already defined. 

Please note: With this type of breakdown, you must enter your data in decreasing order of diameters, as 
Optitek applies the first saw opening that satisfies the minimum diameter condition. 

 
 

Figure 57 Pre-selecting openings for user-defined log diameter classes 
 
 
In the example above ( Figure 57), we selected an opening of 7.75 inches for all logs with 
small-end diameters of 8.5 inches or more. We selected an opening of 5.75 inches for all 
logs with small-end diameters of 6.5 inches or more but not exceeding 8.5 inches. Finally, 
we selected an opening of 3.75 inches for logs with small-end diameters of 4 inches or 
more but not exceeding 6.5 inches. Logs that do not qualify under these classes (small-
end diameters below 4 inches) are sent directly to the chipper. 

                                                      
 
1 The diameter you enter is the diameter of the last section measured at the small end of the stem, as readings 
   cannot be taken at any other location. 
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Figure 58 Positions by diameters set option 
 
 
Position by diameters set  

This type of breakdown follows the same principle as the Openings by diameters set 
option. To position the blades, refer to Openings by diameters set, on page 59. 

In the example above ( Figure 58), logs with small-end diameters of 5.5 inches or more are 
sawn by a blade positioned 2.13 inches to the left of the centered axis, and a second 
blade positioned 2 inches to the right of the centre. The size of the cant or two-sided cant 
will therefore be 4 inches, given the saw kerf width of 0.130 inch. 
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Chipper-Canter, Straight Sawing (Primary Breakdown) 

The chipper-canter (or canter) is equipped with two chipping heads mounted on separate 
mobile frames. 

 
 

Figure 59 Graphic representation of a chipper-canter 
 
 
This machine centre ( Figure 59) involves one inflow (left-hand button) and one outflow 
(right-hand button). At the primary breakdown phase, it processes logs. It produces a two-
sided cant. Optitek automatically calculates the chips resulting from this operation. 

 
Positioning 

Two-sided cant  

These options do 
not apply to the 
primary breakdown. 

 

Log 
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Previous position 

This option is rarely used, but you can use it if you want to break down a log in exactly the 
same position as the way it was scanned, with no rotation. If, for example, your mill has a 
first canter with no log-turner and the logs are scanned at the beginning of the production 
line, you should check the Previous position option without clicking on any centering 
option. 

Sweep up 

With this positioning option ( Figure 60) the sweep of the log is automatically on top (horns 
down). You may search for the optimum position in alignment, translation and rotation 
(Refer to Rotation, Alignment and Translation, page 39). 

 
 

Figure 60 Sweep up position 
 
 

Centering 

Once you have selected the basic positioning mode, you need to specify how it should be 
centered with respect to the cutting tools ( Figure 61). 
 

 
 

Figure 61 Centering 
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Full taper 

This option automatically aligns the log parallel to its taper. The origin of the Z reference 
axis runs through the centre of the large end of the log and is parallel to its left-hand side 
( Figure 62). 

 
 

Figure 62 Full taper position 
 
 
Split taper 

This option sets a centered reference axis (split taper), but the axis does not necessarily 
run through the geometric centres of both ends. The reference line starts at the centre of 
the large end, and it continues at the centre of the support, the log being held by its sides, 
as would be the case when self-centering belts are used. 

Centering by ends 

With this option ( Figure 63), the reference axis is centered and runs through the geometric 
centres of the large and small ends of the log. Use this option when you need to centre log 
ends, as with an end-dogging system. 

 



 67 
 
 
 

 
 

Figure 63 Centering by ends 
 
 

Breakdown 

Openings set 

This type of breakdown automatically centres the width of the opening on the reference 
axis selected in the positioning mode. Depending on whether you chose full taper or split 
taper, you will get different results from the Openings set. 

You may specify different openings in a simulation ( Figure 64). Optitek selects the opening 
that optimizes volume or value yield (according to your selection criterion). If you specify 
two openings, Optitek successively breaks down the log with these two openings, and 
selects the opening that provides the better yield in terms of volume or value. 
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List of 
available 
openings 

Enter each opening 
value here and click 
on Add. 

Figure 64 List of openings 
 
 

Positions set 

As with the Openings set option, all positions are determined in relation to the reference 
axis you selected (full taper or split taper), but you must define actual chipping head 
positions by entering the position of the left-side head and that of the right-side head. 
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Example 
 
Calculation of saw positions for a 10-cm opening centered on a centered reference axis (split 
taper) ( Figure 65). For the width of the cutting to be properly centered, you need to apply one-
half of the opening (10 cm/2 = 5.00 cm) on either side of the reference axis you selected. You 
can therefore enter 5.00 cm. 

 

(Right-side position) (Left-side position)  

Figure 65 Example of chipping head position calculation 
 
 
Openings by diameter set 

This type of breakdown is similar to Openings set, but it lets you associate the small-end 
diameter2 of a log to a specific opening. You can therefore pre-select an opening for each 
of the diameter classes you may have already defined. 
 

Please note: With this type of breakdown, you must enter your data in decreasing order of diameters, as  
Optitek applies the first saw opening that satisfies the minimum diameter condition 

 
                                                      
 
2 The diameter you enter is the diameter of the last section measured at the small end of the stem, as readings 
   cannot be taken at any other location. 
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Figure 66 Openings by diameter set option 
 
 

In  Figure 65 we selected an opening of 7.75 inches for all logs with small-end diameters of 
8.5 inches or more. We selected an opening of 5.75 inches for all logs with small-end 
diameters of 6.5 inches or more but not exceeding 8.5 inches. Finally, we selected an 
opening of 3.75 inches for logs with small-end diameters of 4 inches or more but not 
exceeding 6.5 inches. Logs that do not qualify under these classes (small-end diameters 
below 4 inches) are sent directly to the chipper. 

Positions by diameters set 

This type of breakdown is similar to Openings by diameters set, but you enter chipping 
head positions rather than openings. 
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Figure 67 Example of Positions by diameters set option 
 
 

In the above example ( Figure 67), for logs with diameters of 5 inches or more, the 
chipping heads are positioned 2 inches from the reference axis, which is located at the 
centre of the log. The resulting thickness of the cutting will be 4 inches. 
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Chipper-Canter, Curve Sawing (Secondary Breakdown) 

The curve-sawing chipper-canter is equipped with two chipping heads mounted on 
separate mobile frames, and is capable of cutting wood pieces along their curvature. 
Curve sawing is typically a secondary breakdown operation, but the information provided 
on parameter setting is equally applicable to curve sawing in a primary breakdown 
operation. 

 
4-face cant  Two-sided cant 

 
 
 
 
 

Figure 68 Graphic representation of a curve-sawing chipper-canter 
 
 
This machine centre ( Figure 68) involves one inflow (left-hand button) and one outflow 
(right-hand button). It generally processes two-sided cants and generates 4-face cants. 
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Positioning 

 

This option does not 
normally apply to a canter 
used for the secondary 
breakdown  
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Left side 

With this option, the left-side face of the two-sided cant produced at the previous machine 
centre is placed facing down. This type of positioning lets you perform alignment and 
translation searches. 

 
 

Figure 69 Left side positioning 
 
 
Right side 

With this option ( Figure 70), the right-side face of the two-sided cant produced at the 
previous machine centre is placed facing down. This type of positioning lets you perform 
alignment and translation searches. 

 
 

Figure 70 Right side positioning 
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Previous side 

The side placed facing down is the last side produced at the previous machine centre. 
This option is less common in secondary breakdown canters, as two-sided cants already 
have a left side and a right side generated simultaneously at the previous machine centre. 
If, however, you select Previous side, the right side is placed facing down by default.  

Curve Sawing Parameters 

As soon as you click on one of the positioning options, Optitek displays the following 
window. Use it to configure specific curve sawing parameters 

 

Path: Selects the type of 
curve sawing and the 
parameters defining the 
curve to be followed. 

Referential: Sets the cant 
centering mode as well as 
some mechanical 
parameters of the curve 
sawing machine. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Optimization: If applicable, 

selects alignment and 
translation search 
parameters 

 
 
 
 
 
 
 

Figure 71 Curve sawing parameters 
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Path 

Natural curve sawing  

The natural path mechanically follows the external geometry of the log or two-sided cant. 
There is no limit to the number of curves. The following machines use natural curve 
sawing: Comact’s DDM, Sawquip’s chipping canter for cant, HewSaw machine. 

 

  
 

Figure 72 Natural path curve sawing 
 
 

The natural curve sawing parameters are as follows: 

  

 Minimum curvature radius 

Curve sawing capacity of the machine centre. A high radius means that the machine 
cannot follow sharp curves. The radius you enter must be higher than zero. If you 
cannot obtain this information from the machine parameters, ask your supplier. 
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Here are two examples: 

- Sawquip’s chipping canter for cant: 500 inches 
- Comact’s DDM:  500 to 800 inches 

 

RR

R-C

C
L/2L /2

 
 

Figure 73 Conversion between radius of curvature and sweep 
 
 

As an example, here is how you can calculate the radius of curvature from the sweep you 
have measured directly off a log: 

L  = log length  = 96 inches 
C = log sweep = 1 inch 
R = radius of curvature 
    = ( ( L / 2 )2 + C2 ) / ( 2 x C ) 
    = 1152.5 inches 
 
With a minimum radius of 1152.5 inches, you could therefore curve-saw an 8-foot log with 
a sweep of 1-inch. 

 Straight length 

This refers to the length of straight cutting before the curved path ( Figure 74). Depending 
on the equipment you are simulating, you can optimize or force the straight length by 
entering three parameters: Step, Min. and Max.. All entries must be zero or higher; the 
maximum must be higher than or equal to the minimum, and the step must be set so you 
can search the whole range between the minimum and the maximum.  

Please note: For natural curve sawing, this parameter is usually left at zero. 
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Figure 74 Straight length 

 
Arc-of–a-circle sawing  

If curve sawing follows an arc of a circle, the path is determined through mathematical 
calculations on the basis of the parameters you enter ( Figure 75). The path follows the 
same curve along a given piece of wood, and the system selects the arc generating the 
best recovery. Machines using this method include the curve sawing gang saw edger with 
a hinge from Comact. 

 
Figure 75 Curve sawing in an arc-of-a-circle 

 
The parameters defining curve sawing in an arc-of-a-circle are as follows:  

 Minimum radius of curvature 

Curve sawing capacity of the machine centre. A high radius means that the machine 
cannot follow a sharp curve. The radius you enter must be higher than zero. If you 
cannot obtain this information from the machine parameters, ask your supplier.  As an 
example, the minimum radius of curvature of Comact’s hinged gang edger is usually 
in the neighbourhood of 3500 inches. 

 

 Straight length 

  

Min Step Max. 
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This refers to the length of straight cutting before the curved path ( Figure 76). 
Depending on the equipment you are simulating, you can optimize or force the 

s hinged gang edger, you should set the step at zero, with equal values 
for the minimum and the maximum at about 30 inches. With these parameters, the 

 

s to curve sawing in an arc of a circle. It provides for identifying the 
curvature that will generate the best yield. The curvature refers to the final deviation of 

 

 

Figure 76 

awing  

llows the external geometry of the two-sided cant or log 
by using the least squares method on the entire length of the piece. Constraints due to the 

straight length by entering three parameters: Step, Min. and Max. All entries must be 
zero or higher; the maximum must be higher than or equal to the minimum, and the 
step must be set so the whole range between the minimum and the maximum can be 
searched. 

For Comact’

machine has to cut straight over 30 inches before it can cut in a curve. 

Curvature 

Only applie

the path against the straight referential. By selecting three entries (Step, Min. and 
Max.), you can limit the search for the best curvature to a single direction 
(left=negative; right=positive) or allow total freedom. The values you enter can be 
positive, negative or equal to zero; the maximum must be higher than or equal to the 
minimum; and the step must be such that the whole range between the minimum and 
the maximum can be searched ( Figure 76). 

Pas

max

min -3.0

.5
Straight length 

Curvature 

3.0

1.5

0.0

-1

 
Search for curvature 
 
Polynomial curve s

Polynomial type curve sawing fo

minimum radius of curvature and entries forcing a minimum straight line may affect the 
initial path. The degrees assigned to the polynom (2 or 3) determine the number of curves 
(1 or 2 respectively) in the piece of wood. Machines using this method include Comact’s 
TBL 2 and McGehee’s edger. 
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Figure 77 Polynomial curve sawing (polynom degree 2) 
 

 
Figure 78 Polynomial curve sawing (polynom degree 3) 

 
The parameters defining polynomial curve sawing are as follows:  

 Minimum radius of curvature  

Curve sawing capacity of the machine centre. A high radius means that the machine 
cannot follow a sharp curve. The radius you enter must be higher than zero. If you 
cannot obtain this information from the machine parameters, ask your supplier.  As an 
example, the minimum radius of curvature of Comact’s TBL 2 is usually in the 
neighbourhood of 2000 inches. 

 Straight length 

This refers to the length of straight cutting before the curved path ( Figure 76). 
Depending on the equipment you are simulating, you can optimize or force the 
straight length by entering three parameters: Step, Min. and Max. All entries must be 
zero or higher; the maximum must be higher than or equal to the minimum, and the 
step must be set so the whole range between the minimum and the maximum can be 
searched. 
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Please note: For polynomial curve sawing, this parameter is usually left at zero. 

Referential 

Split taper/Full taper 

Determines the referential centering mode for positioning. In the Split taper mode, the 
referential is based on the geometric centre of the piece; this is the only option available in 
natural curve sawing. In the Full taper mode, the referential is based on the left side of the 
piece. 

Limited\Continuous 

Relates to the nature of the positioning mechanism. If you use this option, you must enter 
parameters for Distance and Span. In the Limited mode, sets or rollers are applied to the 
sides of the two-sided cant or log; this option is only available with natural curve sawing. In 
the Continuous mode, guide bars are applied to the sides of the piece of wood; this is the 
obligatory option in arc-of-a-circle and polynomial sawing. Some natural curve sawing 
machines also use this mode (HewSaw, 1st generation DDM). 

Distance and Span 

These parameters are used to set the activation and deactivation points of the mechanism 
or algorithm on which the positioning referential is based. The Distance parameter sets 
the distance to the cutting tools (saws or knives) at which the positioning mechanism or 
algorithm is activated. The Span parameter sets the length or span over which the 
mechanism or algorithm determines the positioning referential. 

Referential parameters are critical because they determine how the piece of wood will 
initially be cut. By changing these parameters, you change the initial cutting angle of the 
tools; they are easy to measure in a mill. The sketch below ( Figure 79) illustrates the 
distance (d1) and span (d2) concepts. The Distance parameter is the distance between 
the first roller and the cutting tool, while the Span parameter is the distance between the 
two rollers used to position the piece of wood at the initial stage. 

 
 

Figure 79 Illustration of Distance and Span parameters 
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Optimization 

Optimization options and parameters let you identify optimum positions on the basis of the 
referential defined in the previous steps. As in previous steps, the options available are 
limited by the choices you have already made. 

By checking the First point option ( Figure 80), you can shift the positioning referential so 
that it will line up with a square edge (no wane) on the left side of the piece. 

 
Figure 80 First point option 

 
 

Breakdown 

Openings set 

In secondary breakdown operations, the Openings set option is used exclusively with 
split taper positioning. This type of breakdown automatically centres the width of the 
opening in relation to the reference axis determined in the selection of a positioning mode. 
You may specify different openings in a simulation. Optitek will select the opening that 
optimizes volume or value yield (according to your selection criterion). If you specify two 
openings, Optitek successively breaks down the log with these two openings, and selects 
the opening that provides the better yield in terms of volume or value. 
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Figure 81 Openings set option 
 
 
Positions set 

As with Openings set, the Positions set option relates directly to the selected reference 
axis (split taper or full taper), but you determine the position of the knives. 
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Figure 82 Positions set option 
 
 

Gang Saw, Straight Sawing 

The straight sawing gang saw is equipped with multiple circular saw blades mounted on 
one or two arbors. 

Cant 
Lumber piece or slab 

Lumber piece(s) 

Lumber piece or slab 
 

 
This machine centre involves one inflow (left-hand button) and three outflows (right-hand 
buttons). It usually processes two-sided cants or cants. The resulting pieces are as 
follows: the piece furthest to the left outflows through the top button; the piece furthest to 
the right outflows through the bottom button. Note that only one piece of wood can outflow 
through the top or bottom buttons.  If you are processing a cant, the pieces outflowing 
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through the top and bottom buttons are square-edged lumber. If you are processing a two-
sided cant, they are slabs. All other pieces outflow through the centre button. 

Positioning 

 
 

Figure 83 Positioning configuration window 
 
 

Previous position  

With this option, you use the same positioning as with the previous machine centre, which 
lets you perform a search on alignment and translation. At the edger, this is mostly used 
when the piece entering the machine is a 4-face cant from a canter. 

Left side 

With this option, the left-side face of the two-sided cant produced at the previous machine 
centre is placed facing down. This type of positioning lets you perform alignment and 
translation searches. 
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Figure 84 Left side positioning 
 
Right side  

With this positioning option, the right-side face of the piece produced at the previous 
machine centre is placed facing down. This type of positioning allows for alignment and 
translation searches. 

 
 

Figure 85 Right side positioning 
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Previous side 

The side placed facing down is the last side produced at the previous machine centre, or 
the right side by default. If, for example, a two-sided cant has a left side and a right side, 
the Previous side option places the right side down by default. In this case, the result is 
the same as with the Right side positioning option. 
 

 
 

Figure 86 Previous side positioning 
 
Centering 

 
 

Figure 87 Centering option for a straight sawing gang edger 
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Full taper 

This option determines an off-centered reference axis, and simulates a left-hand line-bar. 

 
 

Figure 88 Full taper position  
 
 

Split taper 

This option sets a centered reference axis (split taper), but the axis does not necessarily 
run through the geometric centres of both ends. The reference line starts at the centre of 
the large end, and it continues at the centre of the support, the log being held by its sides, 
as would be the case when self-centering belts are used. 

Centering by the ends 

With this option, the reference axis runs through the geometric centres of the large and 
small ends of the log. Use this option when you need to centre log ends, as with an end-
dogging system or a carriage. 

 
 

Figure 89 Centering by the ends 
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First point 

If you check this option, Optitek tries to identify, in parallel to the reference axis already 
selected for centering (full taper/split taper), a new reference axis corresponding to a 
square edge, of the length specified in the adjacent field, over the whole length of the 
piece of wood. If no dimension is specified in the field, the dimension of the square-edge 
side will be that of the opening specified under Breakdown. 

 

 

Opening

Figure 90 Wane-free width specified to define the square-edge side 
 
 

 
 

Figure 91 First point option 
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Breakdown 

Centered openings set 

In secondary breakdown, the Centered openings set option is only available with split 
taper positioning. If you use this option, the full width of the saw opening is automatically 
centered on the split taper axis. You would use this option in the case of a gang edger with 
no line-bar. 

 
 

Figure 92 Centered openings set used for secondary breakdown (split taper positioning) 
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Positions set 

Unlike the Centered openings set, this option lets you choose between full taper and split 
taper centering. With this type of breakdown, you are free to position each blade in relation 
to the reference axis determined under the Positioning section. 

 
 

The example shown in the figure relates to 
a gang saw fed by a linear positioning 
table. The alignment and translation 
parameters simulate the linear table. 

 
In this case, the gang saw is equipped with 
four blades, each having a saw kerf width 
of 0.130 inch. The spacing between the 
blades is 1.700 inches, which will 
determine the thickness of the resulting 
lumber.

Enter the target lumber 
thickness here. 

Then click on Add 

Figure 93 Positions set option with full taper 
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To enter saw blade positions, click 
on New. In the window that is 
displayed, enter the position of the 
first blade. Click on OK. 

 
Repeat the same steps for the 
other blade positions. There is no 
need to enter the total number of 
blades, as Optitek automatically 
calculates it from the number of 
positions you have entered. 

 
When you have entered all the 
positions, click on Add to create the
positions set. 

This example relates to a gang saw with a 
line-bar, used to process two-sided cants. 
Full taper positioning is used. The gang 
saw is equipped with six blades, each with 
a saw kerf width of 0.130 inch. 

 
The first blade is positioned 0.75 inch from 
the line-bar. The positions of the next 
blades are calculated by adding 1.83 inch 
to the previous position (1.700 inch for 
lumber thickness and 0.130 inch for saw 
kerf).
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This example relates to a gang saw with a 
line-bar that processes cants (see below). 
Full taper centering is used. The gang saw 
is equipped with six blades, each with a 
saw kerf width of 0.130 inch. 

 
As no slab is produced at the gang saw, 
the position of the first blade is determined 
by the thickness of the lumber, i.e., 1.700 
inch. To calculate the next positions, add 
1.83 inch to the previous position (1.700 
inch for the lumber thickness and 0.130 
inch for the saw kerf). 
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Gang Saw, Curve Sawing 

Please note: Whenever the machine centre preceding the gang saw is a curve-sawing machine (e.g., 
Sawquip’s chipping canter for cant or Comact's TBL2), the resulting cants must be processed on a 
straight sawing gang saw. This section applies only to gang saws producing the first curve sawing 
operation. 

The curve sawing gang saw is equipped with circular saw blades mounted on one or two 
arbors. It is capable of sawing pieces of wood according to their curvature. 

 
 

Lumber piece or slab 

Lumber piece or slab 
Lumber piece(s) Cant 

Figure 94 Graphic representation of a curve sawing gang saw 
 
 
This machine centre involves one inflow (left-hand button) and three outflows (right-hand 
buttons). It typically processes two-sided cants or cants. The resulting pieces are 
distributed as follows. The furthest left piece outflows through the top button. The furthest 
right piece outflows through the bottom button. Note that only one piece ever outflows 
through each of the top and bottom buttons. If the machine processes a cant, the pieces 
coming out of the top and bottom buttons are square; in the case of a two-sided cant, they 
are slabs. All other pieces outflow through the centre button. 

Positioning 

 
 

Figure 95 Positioning configuration window 
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Left side 

With this option, the left-side face of the piece produced at the previous machine centre is 
placed facing down. This type of positioning lets you perform alignment and translation 
searches. 

 
 

Figure 96 Left side positioning 
 
 

Right side 

With this option, the right-side face of the two-sided cant produced at the previous 
machine centre is placed facing down. This type of positioning also lets you perform 
alignment and translation searches. 

 
 

Figure 97 Right side positioning 

 



96  

 
 
 

Previous side 

The side placed facing down is the last side produced at the previous machine centre. 
This option is less common in secondary breakdown canters, as two-sided cants already 
have a left side and a right side generated simultaneously at the previous machine centre. 
If, however, you select Previous side, the right side is placed facing down by default. 

Previous position 

With this option, you automatically use the same positioning as with the previous machine 
centre, which allows for searches on alignment and translation. 

Curve sawing parameters 

As soon as you click on one of the positioning options, Optitek displays the following 
window. Use it to configure curve sawing parameters. 

Path: Selects the type of 
curve sawing and the 
parameters defining the 
curve to be followed. 

Referential: Sets the cant 
centering mode as well as 
some mechanical 
parameters of the curve 
sawing machine. 

 

 

 

 

 

 

 

Optimization: If applicable, 
selects alignment and 
translation search 
parameters 

 

 

 

 
 
Path 

Natural curve sawing 

The natural path mechanically follows the external geometry of the log or two-sided cant. 
There is no limit to the number of curves. The following machines use natural curve 
sawing: Comact’s DDM, Sawquip’s chipping canter for cant, HewSaw machine. 
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Figure 98 Natural path curve sawing 

 
The natural curve sawing parameters are as follows: 

  

 Minimum curvature radius 

Curve sawing capacity of the machine centre. A high radius means that the machine 
cannot follow sharp curves. The radius you enter must be higher than zero. If you 
cannot obtain this information from the machine parameters, ask your supplier. 

Here are two examples: 

- Sawquip’s chipping canter for cant: 500 inches 
- Comact’s DDM:  1500 inches 
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Figure 99 Conversion between radius of curvature and sweep 
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As an example, here is how you can calculate the radius of curvature from the sweep 
you have measured directly off a log: 

L  = log length  = 96 inches 
C = log sweep = 1 inch 
R = radius of curvature 

        = ( ( L / 2 )2 + C2 ) / ( 2 x C ) 
           = 1152.5 inches 
 

With a minimum radius of 1152.5 inches, you could therefore curve-saw an 8-foot log 
with a sweep of 1-inch. 

 Straight length 

This refers to length of straight cutting before the curved path. Depending on the 
equipment you are simulating, you can optimize or force the straight length by entering 
three parameters: Step, Min. and Max. All entries must be zero or higher; the 
maximum must be higher than or equal to the minimum, and the step must be set so 
you can search the whole range between the minimum and the maximum. 

Please note: For natural curve sawing, this parameter is usually left at zero. 

 

Min. Step Max.

 
Figure 100 Straight length 

 
Arc-of–a-circle sawing  

If curve sawing follows an arc of a circle, the path is determined through mathematical 
calculations on the basis of the parameters you enter. The path follows the same curve 
along a given piece of wood, and the system selects the arc generating the best recovery. 
Machines using this method include: edgers such as Comact’s “Wiggle Box”. 
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Figure 101 Curve sawing path in an arc-of-a-circle 

 
The parameters defining curve sawing in an arc-of-a -ircle are as follows:  

  

 Minimum radius of curvature  

Curve sawing capacity of the machine centre. A high radius means that the machine 
cannot follow a sharp curve. The radius you enter must be higher than zero. If you 
cannot obtain this information from the machine parameters, ask your supplier.  As an 
example, the minimum radius of curvature of Comact’s “Wiggle Box” gang edger is 
usually in the neighbourhood of 3500 inches. 

 Straight length 

This refers to the length of straight cutting before the curved path. Depending on the 
equipment you are simulating, you can optimize or force the straight length by 
entering three parameters: Step, Min. and Max. All entries must be zero or higher; the 
maximum must be higher than or equal to the minimum, and the step must be set so 
the whole range between the minimum and the maximum can be searched. 

Please note: With natural curve sawing machines, this parameter is usually left at zero. 

For Comact’s “Wiggle Box” gang edger, you should set the step at zero, with equal 
values for the minimum and the maximum at about 30 inches. With these parameters, 
the machine has to cut straight over 30 inches before it can cut in a curve. 

 Curvature 

Only applies to curve sawing in an arc of a circle. It provides for identifying the 
curvature that will generate the best yield. The curvature refers to the final deviation of 
the path against the straight referential. By selecting three entries (Step, Min. and 
Max.), you can limit the search for the best curvature to a single direction 
(left=negative; right=positive) or allow total freedom. The values you enter can be 
positive, negative or equal to zero; the maximum must be higher than or equal to the 
minimum; and the step must be such that the whole range between the minimum and 
the maximum can be searched. 

 



100  
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Straight length step
0.0
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Figure 102 Search for curvature 

 
Polynomial curve sawing  

Polynomial type curve sawing follows the external geometry of the two-sided cant or log 
logically by using the least squares method on the entire length of the piece. Constraints 
due to the minimum radius of curvature and entries forcing a minimum straight line may 
affect the initial path. The degrees assigned to the polynom (2 or 3) determine the number 
of curves (1 or 2 respectively) in the piece of wood. Machines using this method include 
Comact’s TBL 2 and McGehee’s edger. 

 
 

 

  

Figure 103 Polynomial curve sawing (polynom degree 2) 
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Figure 104 Polynomial curve sawing (polynom degree 3) 

 
The parameters defining polynomial curve sawing are as follows:  

  

 Minimum radius of curvature  

Curve sawing capacity of the machine centre. A high radius means that the machine 
cannot follow a sharp curve. The radius you enter must be higher than zero. If you 
cannot obtain this information from the machine parameters, ask your supplier.  As an 
example, the minimum radius of curvature of Comact’s TBL 2 is usually in the 
neighbourhood of 2000 inches. 

 Straight length 

This refers to the length of straight cutting before the curved path. Depending on the 
equipment you are simulating, you can optimize or force the straight length by 
entering three parameters: Step, Min. and Max. All entries must be zero or higher; the 
maximum must be higher than or equal to the minimum, and the step must be set so 
the whole range between the minimum and the maximum can be searched. 

Please note: For polynomial curve sawing, this parameter is usually left at zero. 

Referential 

Split taper/Full taper 

Determines the referential centering mode for positioning. In the Split taper mode, the 
referential is based on the geometric centre of the piece; this is the only option available in 
natural curve sawing. In the Full taper mode, the referential is based on the left side of the 
piece. 
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Limited/Continuous 

Relates to the nature of the positioning mechanism. If you use this option, you must enter 
parameters for Distance and Span. In the Ponctual mode, sets or rollers are applied to 
the sides of the two-sided cant or log; this option is only available with natural curve 
sawing. In the Continuous mode, guide bars are applied to the sides of the piece of 
wood; this is the obligatory option in arc-of-a-circle and polynomial sawing. Some natural 
curve sawing machines also use this mode (HewSaw, 1st generation DDM). 

Distance and Span 

These parameters are used to set the activation and deactivation points of the mechanism 
or algorithm on which the positioning referential is based. The Distance parameter sets 
the distance to the cutting tools (saws or knives) at which the positioning mechanism or 
algorithm is activated. The Span parameter sets the length or span over which the 
mechanism or algorithm determines the positioning referential. 

Referential parameters are critical because they determine how the piece of wood will 
initially be cut. By changing these parameters, you change the initial cutting angle of the 
tools; they are easy to measure in a mill. The sketch below illustrates the distance (d1) 
and span (d2) concepts. The Distance parameter is the distance between the first roller 
and the cutting tool, while the Span parameter is the distance between the two rollers 
used to position the piece of wood at the initial stage ( Figure 105). 

 
Figure 105 Illustration of Distance and Span parameters 

 
 

Optimization 

Optimization options and parameters let you identify optimum positions on the basis of the 
referential defined in the previous steps. As in previous steps, the options available are 
limited by the choices you have already made. 

By checking the First point option ( Figure 106) you can shift the positioning referential so 
that it will line up with a square edge (no wane) on the left side of the piece. 
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Figure 106 First point option 

 
 

  

Breakdown 

Centered openings set 

In secondary breakdown operations, the Openings set option is used exclusively with 
split taper positioning. This type of breakdown automatically centres the full width of the 
opening in relation to the split taper reference axis ( Figure 107). Machines using this 
setting include gang saws without line-bars. 

 
Figure 107 Openings set used in secondary breakdown (split taper) 
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Then click on Add 

Enter the thickness of the 
lumber to be produced. 

Figure 108 Example of gang saw using split taper openings set 
 
 

In the above example ( Figure 108), the gang saw is equipped with four blades, each with 
a saw kerf width of 0.130 inch. The spacing between the blades is 1.700 inches, which 
corresponds to the thickness of the lumber to be produced. 
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Positions set 

Unlike Centered openings set, the Positions set option can be used in both full taper 
and split taper modes ( Figure 109). With this type of breakdown, you can position each 
blade in relation to the reference axis selected at the positioning stage. Calculated 
positions relate to the left side of each blade. 

 

 
 

Figure 109 Positions set in full taper mode 
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To enter saw blade positions, click on New button 
Enter the position of the first blade in the pop up 
window. Then click on OK. 

 
Repeat these steps with the other saw blades. 
There is no need to enter the total number of 
blades, as Optitek automatically calculates the 
number of positions you have entered. 

 
When you have finished entering your positions, 
click on the Add button to create the positions set. 

Figure 110 Example of a gang saw with line-bar used to process two-sided cants (full taper   
 mode) 

 
 

In the above example ( Figure 110), the gang saw is equipped with six saw blades, each 
with a saw kerf width of 0.130 inch.  The first blade is positioned at 0.75 inch from the line-
bar. The other blade positions have been calculated by adding 1.83 inch to the previous 
position (1.700 inch for lumber thickness and 0.130 inch for saw kerf). 
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Edger 

The edger is a secondary breakdown machine equipped with two saw blades. It is used to 
edge wany boards or two-sided cants into lumber of uniform width. Note that, to simulate a 
three-blade edger, it is better to use a gang saw. To simulate a chipping edger, you can 
also use this method; just leave blade thickness at zero. 

 
Figure 111 Graphic representation of a two-blade edger 

 
 

This machine centre involves one inflow (left-hand button) and three outflows (right-hand 
buttons). It is normally used to process wany pieces or slabs, and it produces edged 
lumber, which outflows through the centre button. Edgings (the residues) outflow through 
the top and bottom buttons to be converted into chips by a chipper ( Figure 111). 

Edgings 

Edgings 
Edged piece Wany piece 

Positioning 

 
 

Figure 112 Positioning configuration window 
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Previous position 

With this option, positioning is the same as with the previous machine centre, which allows 
the search to focus on alignment and translation. Use this option when the edger is 
located after a resaw. 

Left side 

With this option, the left side face of the two-sided cant produced at the previous machine 
centre is placed facing down. This type of positioning also allows for alignment and 
translation searches. The following example ( Figure 113) illustrates the case of a slab 
resulting from the right side of a twin blade saw. The left side of the piece is therefore 
placed facing down. 

 
 

Figure 113 Slab originating from the right side of a twin blade saw 
 
 
Right side 

With this option, the right side face of the two-sided cant produced at the previous 
machine centre is placed facing down. This type of positioning also allows for alignment 
and translation searches. 

Previous side 

The side placed facing down is the last side produced at the previous machine centre. In 
the case illustrated below ( Figure 114), the slab only has one straight side, as its left side 
has not been machined. The Previous side option positions the slab right face down by 
default. In this case, the Previous side option achieves the same result as the Right side 
option. The Previous side option is very convenient when you want to properly position 
the two slabs produced by a twin band saw. 
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Figure 114 Previous side positioning 
 
 

Centering 

Full taper 

This type of positioning determines an off-centered reference axis, and simulates a 
reference line (line-bar) on the left-hand side. 

Split taper 

This option sets a centered reference axis (split taper), but the axis does not necessarily 
run through the geometric centres of both ends. The reference line starts at the centre of 
the large end, and it continues at the centre of the support, the log being held by its sides, 
as would be the case when self-centering belts are used. 

Centering by ends 

With this option, the reference axis runs through the geometric centres of the large and 
small ends ( Figure 115). 
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Figure 115 Centering by ends 
 
 
First point 

If you check this option, Optitek tries to identify, in parallel to the reference axis already 
selected for centering (full taper/split taper), a new reference axis corresponding to a 
square edge, of the length specified in the adjacent field, over the whole length of the 
piece of wood. If no dimension is specified in the field, the dimension of the square-edge 
side will be that of the opening specified under Breakdown. 

Breakdown 

Centered openings set 

In the secondary breakdown, the Centered openings set option is only available with split 
taper positioning. If you use this option, the full width of the saw opening is automatically 
centered on the split taper axis. Machines using the Centered openings set option 
include: 

- edgers with fixed line-bar at the infeed only 
- edgers with completely manual infeed and alignment (no line-bar) 
- optimized edgers with translation and alignment parameters. 
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Figure 116 Centered openings set in a secondary breakdown operation 
 

 
 

To simulate a chipping edger, set the 
saw blade thickness to zero 

Figure 117 Example of a twin-blade edger 
 
 

In the above example ( Figure 117), we have configured a twin-blade edger to produce the 
following nominal lumber sizes: 3, 4 and 6 inches. Both blades have a saw kerf width of 
0.150 inch. 
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Positions set 

Unlike Centered openings set, this option lets you choose between full taper and split 
taper centering. With this type of breakdown, you are free to position each blade in relation 
to the reference axis determined under the Positioning section. Note that the calculated 
position corresponds to the left side of the blade. One example where you would use this 
option is that of an edger with a line-bar, a fixed blade and a mobile blade. 

 
 

Figure 118 Example of Positions set configuration applied to an edger 
 
 
In the above example ( Figure 118), the piece of wood to be edged is placed against a line-
bar (full-taper position). The left blade still removes 0.5 inch of wood from the line-bar, 
while the second saw is positioned according to the desired width. 
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Horizontal Resaw 

The horizontal resaw is a secondary breakdown machine centre that is used to cut lumber 
or slabs into thinner pieces. 

 

 
 

Figure 119 Graphic representation of a resaw 
 
 
This machine centre involves one inflow (left button) and two outflows (right buttons). It 
normally processes a slab or a wany piece of lumber produced by another machine 
centre. The remaining wood outflows through the bottom button while the good piece of 
lumber outflows through the top button ( Figure 119). 

Please note: In Optitek, the resaw may be located before or after the edger as it would be on a “reman” 
line successively performing edging and resawing operations. Note that positioning options vary with 
the order in which these two machines are placed. 

Remaining wood 

Lumber Lumber or slab 
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Positioning 

 
 

Figure 120 Positioning configuration window 
 
 
Previous position 

With this option, positioning is automatically the same as with the previous machine 
centre. Use it when the resaw is located ahead of the edger. 

Left side 

With this option, the left side face of the piece produced at the previous machine centre is 
placed facing down. The example below ( Figure 121) illustrates the case of a slab 
produced to the right of a twin blade saw. In the resaw, its left side is placed facing down. 
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Figure 121 Slab produced to the right side of a twin blade saw 
 
 
Right side 

With this option, the right side resulting from the previous machine centre is placed facing 
down. 

Previous side 

The side placed facing down is the last side produced at the previous machine centre. In 
the case illustrated below ( Figure 122), the slab only has a right side, as its left side has 
not been machined. The Previous side option places the right side facing down by 
default. In this case, the result is the same as with the Right side option. The Previous 
side positioning option is very convenient when you want to adequately position the two 
slabs produced by a twin band saw. 
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Figure 122 Previous side positioning 
 

 

Breakdown  

The horizontal resaw only allows for one type of breakdown, the Openings set. 

 
 

To simulate a chipping resaw, 
set the saw thickness to zero 

Figure 123 Breakdown configuration window 
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End Trimmer 

The end trimmer involves two circular saw blades mounted at either end of the infeed 
table. It is used to trim lumber into commercial lengths and eliminate end defects. 

 
 

Good piece 

Excess 

Excess

Lumber piece 

Figure 124 Graphic representation of an end trimmer 
 
 

This machine centre involves one inflow (left-hand button) and three outflows (right-hand 
buttons). It is normally used to process pieces cut to the same thickness or width, whose 
optimal length needs to be determined. The left end of the piece outflows through the top 
button, while the right end outflows through the bottom button. These ends are usually 
directed to the chipper. The trimmed piece outflows through the centre button ( Figure 
124). 

 

Positioning 

 
 

Figure 125 Positioning configuration window 
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Large end at origin 

This is the most commonly used position with trimmers. Note that large end refers to the 
back end of the pieces coming out of the breakdown machines where they originate 
( Figure 126). By adding search parameters for translation, you can simulate optimized 
trimming or manual trimming. See examples in  Figure 130 and  Figure 131. 

 
 

Figure 126 Large end at origin positioning 
 
Small end at origin 

Rarely used to simulate end trimmers. Note that small end refers to the front end of the 
pieces moving into the breakdown machines where they originate ( Figure 127). By adding 
search parameters for translation, you can simulate optimized trimming or manual 
trimming. 
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Figure 127 Small end at origin positioning 

 
 

Centre of piece at origin 

This type of positioning is rarely used with end trimmers. In this case, the reference axis is 
based on the longitudinal centre of the piece. The option also allows for translation 
searches. 

 

Breakdown 

 
 

Figure 128 Breakdown configuration window 
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Openings set 

This rarely used breakdown mode is only used with the Centre of piece at origin 
positioning option. 

Positions set 

For this breakdown mode, you need to calculate each blade position against a centered or 
off-centered axis, keeping in mind that end trimming does not consider saw kerfs ( Figure 
129). 

 
Figure 129 Positions set 

 
 

The following figures provide examples for the configuration of optimized trimmers using 
the large end at origin positioning option ( Figure 130) and the Positions set breakdown 
option ( Figure 131). 
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Figure 130 Example of an 8-foot trimmer 
 
 

In the above example ( Figure 130), you can use the translation parameters to test three 
sets of positions defined at different positions of the piece. The piece is first backed off 24 
inches for a first translation test. It is then moved in 6-inch steps to the zero position, 
corresponding to the large end at origin. Each combination of positions makes it possible 
to cut the piece to one of three lengths: 76, 86 or 98 inches. The first blade (left saw) is 
always set to 0.5 inch to ensure that the large end is trimmed by at least 0.5 inch. To 
position the second blade, add the target length to the position of the first blade, e.g., 0.5 + 
86 = 86.5). 
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Figure 131 Example of a 16-foot trimmer 
 
 

In the above example ( Figure 131), we have represented a trimmer with saw blades on 
two-foot spacings:  

Saw 0- 0’ 
Saw 1- 2’ 
Saw 2- 8’ 
Saw 3- 10’ 
Saw 4- 12’ 
Saw 5- 14’ 
Saw 6- 16’ 
 
The list shows all the combinations that the blades can produce. The translation 
parameters represent the fence system moving the piece over a maximum span of 24 
inches. 

Openings by lengths set 

This unusual type of breakdown is used exclusively with the Centre of piece at origin 
positioning option. 
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Positions by lengths set 

Use this breakdown option to set blade positions in such a way as to trim the lumber 
according to initial length as delivered to the trimmer. This type of breakdown is of 
particular use when you want to reduce simulation time, as it cuts back on the number of 
trials the software needs to perform. 

 
 

Remember to enter saw blade positions in 
decreasing order of length. Optitek starts with 
the first line and checks whether the length of 
the piece is greater or equal to the specified 
length. If it is, it activates the corresponding 
blades. If not, it considers the second line and 
so on. 

The scanner sends pieces with little 
or no wane to the simplified end 
trimmer 

Figure 132 Positions by lengths set option 
 
In the above example ( Figure 132), we divided the trimming operation into two parts by 
using two different trimming centres in Optitek, even though there would only be one 
trimmer in a real mill. Trimmer #11 fully optimizes trimming according to the parameters 
entered by the user (See  Figure 130 and  Figure 131.).  Trimmer #12 is a simplified version 
of the trimmer; it does not do translations, and cuts to a fixed length based on the length of 
the piece fed to it. A scanner located between the two trimmers scans the pieces for wane 
(see Scanning for wane, on page 123). The scanner directs all pieces with little or no 
wane to the simplified trimmer. This method eliminates useless optimization operations on 
many pieces for which the optimal solution is simply the maximum length. 
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For lumber For lumber For stems and logs For stems and logs 

Stem, log or lumber piece Stem, log or lumber piece 
>=line 1 >=line 1 

>=line 2 >=line 2 

Scanner Scanner 
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The scanner can sort out stems, logs or lumber according to a geometric parameter. You 
can find a list of the different possible sorting criteria in  Figure 134. 

 

 

 
 
 
 
 

Figure 133 Graphic representation of a scanner 
 
This machine centre involves one inflow (left-hand button) and two outflows (right-hand 
button). It processes stems, logs or pieces of lumber. Depending on the selected sorting 
criterion, pieces whose value is greater than or equal to that of Line 1 outflow through the 
top button; if their value is lower than that specified on Line 1 but greater than or equal to 
the value specified on Line 2, they outflow through the bottom button. Pieces whose value 
is smaller than both lines are sent directly to the residue chipper ( Figure 133). 

This machine centre is used to simulate scanners as they are found in sawmills, but it only 
works on one criterion at a time. If you want to sort material according to several criteria 
(e.g., diameter, sweep and taper), you need to use several serially connected scanners. 

 

 

 

 

 

 

 

 

Figure 134 Sorting criteria used by scanners 

 



 125 
 
 
 

Scanner Configuration 

Scanning for wane 

Use this option to sort lumber according to maximum wane percentages in thickness or in 
width. As the system cannot distinguish width wane from thickness wane, it always 
evaluates the pieces on the largest proportion of wane, whether in width or in thickness 
( Figure 135). 

 
 

Pieces with one face having 20% or more 
wane are sent to the top button. Those with 
0 to 20% wane are sent to the bottom button.

Figure 135 Configuration window for wane scanning 
 
 

Scanning for median diameter 

Use this option to sort stems or logs according to a reference diameter based on the 
median of readings obtained over a section you have previously defined in terms of 
Distance and Span. 
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Figure 136 Configuration window for median diameter scanning 
 
 

In the example above ( Figure 136), we first selected the reference end (small end or large 
end). As we selected the small end, the Distance parameter was negative. The Distance 
and Span parameters indicate that the median diameter is calculated 24 inches from the 
small end over a span of 12 inches. The Span is divided into two equal parts on either 
side of the Distance. Optitek will therefore calculate the median of all diameters between 
18 and 30 inches from the small end. All logs with median diameters of 8 inches or more 
outflow through the bottom button, while the other logs go directly to the chipper. 

Scanning for average diameter 

Use this option to sort stems or logs according to a reference diameter based on the 
average of readings obtained over a section you have previously defined in terms of 
Distance and Span. 

Scanning for dimensions 

Use this option to sort lumber pieces according to maximum dimensions. This lets you 
check that pieces not meeting minimum dimension criteria are treated differently from 
others. The parameters you enter are used to segregate the lumber in terms of thickness, 
width and length. 
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Please note: The system treats the lumber on the flat (thickness is the vertical dimension, Y axis; width 
is the horizontal dimension, X axis). If it is not the case, as in a gang saw, for example, you must 
reverse the thickness and width values (see  Figure 137). 

 
 

Figure 137 Configuration window for dimension scanning 
 
 

To scan for dimensions, you should preferably use the Centre of piece at origin 
positioning option. The reading number is 3, which means that the piece will be checked at 
three, well-spaced spots along its length, and that Optitek will retain the dimensions 
(thickness and width) providing the highest value. 

In the example above ( Figure 137), we checked pieces of lumber, 192 inches in length, at 
the outfeed of a gang saw. Our objective was to eliminate any lumber that would be too 
small for 2x3x6 feet.   The three readings were made at the centre of the pieces, at -48 
inches from the centre, and +48 inches from the centre.  The piece is therefore distributed 
into four equal-length sections. 

Pieces with one of the three dimensions (thickness, width and length) below the specified 
values are directed to Line 2, i.e., the lower button. Pieces meeting all criteria are directed 
to the top button. 
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Scanning by small end diameter 

Use this option to sort logs according to small end diameters. 

 
 

Figure 138 Configuration window for small end diameter scanning 
 
In the example above ( Figure 138), the logs with diameters over 2.75 inches at the small 
end are directed to the top button, while those between 0 and 2.75 inches go to the bottom 
button. 

Scanning for sweep 

Use this option to scan stem or logs according to sweep. Sweep is the distance between 
the axis joining the centres of the two ends of the log and the geometric centre of its 
central section. Sweep is measured in centimetres of sweep per metre of log or stem 
length, or in inches per 8-foot length, according to the unit system you have selected. 

 
 

Figure 139 Configuration window for sweep scanning 
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In the example above ( Figure 139), logs whose sweep is equal to or greater than 1.25 inch 
per 8 feet are directed to the top button, while the others outflow through the bottom 
button. 

Scanning for length 

Use this option to sort stems, logs or lumber according to maximum length. 

Scanning for taper 

Use this option to sort stems or logs in relation to average taper. The calculation of taper is 
based on the difference between diameters at the two ends of the stem or log. It is 
measured in centimetre per meter of length (cm/m) or in inches per 8-foot length (in/8ft), 
depending on the units in use in the mill. 
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Accumulator 

The accumulator is used to save log data from the slasher in a file. It therefore lets you 
save slashing solutions for further analysis of the logs involved. 

 
 

Figure 140 Graphic representation of an accumulator 
 
This machine centre involves one inflow (left-hand button) and one outflow (right-hand 
button). The logs sent to the accumulator are not processed. The only function of the 
accumulator is to record geometric data relating to the logs. The logs move on through the 
outflow button, which may be connected to a chipper if the only purpose is to create a data 
file on slashing operations. But you can also send the logs on to the sawmill for 
conversion. 

Configuration 

 
 

Figure 141 Configuration window for the accumulator 
 
To configure the accumulator, select the format (two-axes or true shape) in which you 
want to save the logs. The format is not necessarily the same as for the stems from which 
the logs originate. Enter the path and the name of the file where you want to save the log 
data ( Figure 141). 
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Counter 

The main purpose of the counter is to produce simulation reports for the different log or 
stem names. It therefore lets you associate a name with all the logs or stems running 
through it, and you can then use these names as a sorting criterion in simulation reports. 

 
 

Log or stem Log or stem 

Figure 142 Graphic representation of a counter 
 
This conversion centre involves one inflow (left-hand button) and one outflow (right-hand 
button). The logs or stems running through the counter are not processed. Optitek only 
assigns them a name, and they just move on through the outflow button to another 
machine centre ( Figure 142). 

 
 

Figure 143 Configuration window for the counter 
 
The Rejects counter option lets you identify the logs or stems running through the 
counter as rejects, predefined in the report. The name you enter here will be associated 
with all the logs or stems running through the counter. In the example above ( Figure 143), 
the pattern is identified as “2-4-2”, which allows for the material to be sorted in terms of 
patterns. Note that the counter will not change a log's name in the log data file. 
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Shifter 

The shifter lets you try out two different conversion options, and retain the better solution. 

 
 

Figure 144 Graphic representation of a shifter 
 
 
Each outflow button corresponds to one of the options you want to test. You need to 
connect each of these buttons to the first machine centre in the corresponding option. 
Optitek evaluates both options and retains the one delivering the better results. If you want 
to evaluate more than two manufacturing options, you can use more shifters in cascade 
configuration. To save the option retained by Optitek, select Solution to file and enter the 
file name under which you want to save the information. You can then use this file as input 
with the Use input file option. When you do this, Optitek automatically uses the path 
described in this solution file without evaluating the other path option. 
 
 
 

 
 

Use to enter the name of a file you want 
to open or save. You must use a .sol 
extension. If you fail to enter a file name, 
the shifter operates normally, but the file 
is not saved. 

Use to save a solution selected by 
Optitek to a file. 

Use to force a solution previously 
saved in another file. 

Figure 145 Configuration window for a shifter 
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Key to report results  134 
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Simulation Results 
 
The Report tool lets you generate a complete summary of the results obtained from your 
simulation. The report automatically adjusts to the units of measurement selected in the 
Simulation/Settings menu in the Logs and Grades tools, as well as for the by-products. 
If, for example, the Logs tool uses metric units, all data on log diameters, lengths and 
volumes are in metric units. 

 

Key to the Contents of the Report 

The report is divided into several sections. The following key defines the identification 
labels used in the different sections (columns). 

Logs Data 

Class: Log class name defined by the user (See Step 7). If no name has been selected, 
the report displays the names of individual logs. 

AvgDse: Average small end log diameter. 

AvgDle: Average large end log diameter. 

AvgSwp: Average log sweep. 

AvgTap: Average log taper. 

AvgLgt: Average log length. 

AvgVol: Average log volume. 

TotVol: Total log volume in class. 

Nbr: Number of logs in class. 

NbrPct: Percentage class frequency based on log number per class. 

VolPct: Percentage class frequency based on total log volume per class. 

Product Results 

This part of the report displays the number of pieces of each size and grade obtained from 
the breakdown. The “Total” line for each product group (e.g., 2x3 or 2x4) shows the total 
number of pieces obtained in each grade as a result of the simulation. The “Total” line at 
the bottom of the table displays the sum total of all target products obtained in each grade 
as a result of the simulation. 
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By-products Results 

This section displays the results obtained for chips and sawdust. 

Wt: Total mass of by-products generated by the breakdown of each log class (See 
Step 2). 

Wt/Vlg: Mass of by-products obtained per volume unit of logs. 

Wt/lg: Average mass of by-products per log. 

%lg: Percentage of raw material converted into by-products. 

Volume Recovery 

This section displays the results of the simulated breakdown in terms of number of pieces, 
nominal lumber volume and actual volume. 

Tot Nb: Number of lumber pieces obtained in class. 

Nb/lg: Average number of logs obtained in class. 

Nb/Vlg: Average number of lumber pieces obtained per volume unit of logs. 

Tot Vnm: Total nominal volume of lumber obtained in class. 

Vnm/lg: Average nominal volume of lumber per log. 

Vnm/Vlg: Average nominal volume of lumber obtained per volume unit of logs. 

Tot Vrl: Total actual volume of lumber in log class. 

Vrl/lg: Average actual volume of lumber in log class. 

Vrl/Vlg: Total actual volume of lumber as a percentage of total log volume. 

Value Recovery 

Value recovery results display the respective values of the products and by-products 
based on the values assigned to the different lumber products and by-products in the 
Grades tool. These results are shown separately for lumber, chips and sawdust. The last 
three columns indicate totals for lumber and by-products. 

Val/lg: Average lumber, chip and sawdust values (as applicable) per log in class. 

Val/Vlg: Average lumber, chip and sawdust values (as applicable) per volume unit of log 
in class. 
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Val/Vnm: Average lumber, chips and sawdust values (as applicable) per thousand board 
feet (MBf) of products. 

Yield Summary 

This section summarizes the results of the simulation. For each log class defined by the 
user, it displays the volumes and values of the products and by-products generated in the 
simulation. It also shows the percentage distribution (“%” column) of lumber, chips and 
sawdust, which you can use to evaluate fibre utilization in each log class or in the entire lot 
of logs. The first three columns provide data on lumber, chips and sawdust. 

Yield Reciprocal 

This section displays the results in commonly used ratios. For lumber, yield is expressed 
in terms of consumption factor, the reciprocal of recovery. For chips and sawdust, Optitek 
uses the “Wt/Vnm” ratio, which is the mass of by-products over total lumber production in 
board feet. 
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